Agilent ChemStation Edition
For InfinityLab LC/MSD Series and 6100 Series LC/MS

Quick Start Guide

Where to find more information
1
Configuration Diagrams    3
ChemStation Edition Views  4
Basic Operation    17
Deconvolution    22
Operating Tips    24
Troubleshooting Tips    26

This manual applies to OpenLab CDS ChemStation Edition software version C.01.07 SR3 and later until superseded.

Where to find more information

Online Help    Use online Help for in-depth information beyond what is shown in this Quick Start Guide. Display online Help in any of the following ways:
• Click the Help button in the toolbar.
• Select Help Topics from the Help menu.
• Click the Help button on most dialog boxes to show task-specific help.
What’s new in C.01.07

User Guides  Besides this Quick Start Guide, the following guides are available from the Resource App after installation.

- Agilent ChemStation Edition Familiarization Guide
- Agilent InfinityLab LC/MSD Series and 6100 Series LC/MS Concepts Guide
- Agilent InfinityLab LC/MSD Series System Installation Guide
- Agilent InfinityLab LC/MSD Series and 6100 Series LC/MS Maintenance Guide

After installation, open Start > All Programs > Agilent Technologies > OpenLAB CDS Documentation to access manuals for your system. Manuals specific to MSD can be found from the Resource App.

Getting Started  Self-paced training modules to learn about the mass selective detector (MSD) and ChemStation Edition software are available from the Resource App.

What’s new in C.01.07

- Support for Agilent1290 Infinity Multisampler.
- MSD hardware eFamiliarization module
- SR3 Point Patch 1 supports InfinityLab LC/MSD Series mass selective detectors
Configuration Diagrams

InfinityLab LC/MSD Series with 1100/1200/1260/1290 Series LC

Solvent cabinet
Pump
Sampler
Column compartment
Detector
MSD
Solvent bottles
ChemStation Edition Views

The ChemStation Edition software consists of several views. Click one of the view buttons in the lower left corner of the screen, or from the View menu, to change to a different view.

Method and Run Control View  Allows you to set up methods and adjust instrument parameters to inject samples and acquire data one sample at a time or in automated sequences. See the next page for more information.

Data Analysis View  Allows you to perform various data evaluation tasks on chromatograms and spectra, such as integration, quantitation, checking peak purity, deconvolution, and report generation. See page 8 for more information.

Report Layout View  Allows you to design custom report templates to use with the data generated by your ChemStation. See page 11 for more information.

Verification (OQ/PV) View  For use by Agilent service engineers to determine if your system is operating in a predictable manner. This view is useful to show Good Laboratory Practice (GLP) compliance, which some government agencies can require. See page 13 for more information.

Diagnosis View  Allows you to run tests to diagnose instrument problems and access information on how to resolve these problems. The early maintenance feedback (EMF) feature can notify you when it is time to perform system maintenance before a problem occurs. See page 15 for more information.

MSD Tune View  In this view, you can calibrate your MSD automatically. You can also set MS parameters manually for specific types of molecules. See page 16 for more information.
The user interface for Method and Run Control can be configured in two ways during installation. See Agilent InfinityLab LC/MSD Series System Installation Guide for information on installation and configuration.

If your instrument is configured with the Classic user interface, then see ChemStation online Help and these manuals on the Resource App:

- Quick Start Guide
- Familiarization Guide
- Concepts Guide
ChemStation Edition Views
Method and Run Control View

Status and Run Bars: Instrument Control Tab
Right-click the Method icon to see the following commands: Run Time Checklist, Method Information, Edit Entire Method, Method Audit Trail, Print Method, and Help.

System Diagram
Each icon of the system diagram represents one component or module of your system. Click on an icon if you want to edit the method parameters or go to the online Help for that particular component.
Single Sample Tool Set
This toolset allows you to work on methods and run an analysis for a single sample. Move the cursor over a button to view a description of it.

Sequence Tool Set
This toolset allows you to work on sequences and run automated analyses of multiple samples. Move the cursor over a button to view a description of it.

Flow Injection Analysis (FIA)
This toolset allows you to inject multiple samples directly into the detector, which lets you bypass the chromatographic column. The results are sent to a single data file. FIA can be used for method development or for applications that do not require chromatography.

To enable FIA from the system diagram:
- Click the FIA icon.
- Select Edit FIA Series.
- Mark the Enable FIA Series in Method option and edit the FIA Table.
The various tool sets available in Data Analysis View are shown on the following pages. You can view a description of a button by moving the cursor over it.
**Common Tool Set**  This toolset is always present in Data Analysis view.

**Graphics Tool Set**  Allows you to manipulate the graphic display.

**Integration Tool Set**  Allows you to perform integration and reporting tasks on a chromatogram.
ChemStation Edition Views
Data Analysis View

**Calibration Tool Set**  Allows you to perform calibration tasks for quantitation.

**Signal Tool Set**  Allows you to work graphically with the UV or MS signal.

**Purify Tool Set**  Allows you to work graphically with your purification data.

**Spectral Tool Set**  Allows you to perform spectral evaluation tasks.

**Deconvolution Tool Set**  Allows you to transforms mass spectra from multiply-charged ions into a calculated molecular weight.
Report Layout View

**Tool Set**  This toolset is present in the Report Layout view. Move the cursor over a button to view a description of it.

**Tips**
- Edit or create a report layout as described in the online Help.
- To test your report layout, select a calculation technique from the drop-down list box to define how the results are calculated.
- Load a data file. The results are loaded into the report template using the selected calculation.
- Select **File / Add to Report Styles** to add your completed report template to the list of available report styles. Now you can use your customized report within a method.
# Sample Report Layouts (in `CHEM32\REPSTYLE`)

<table>
<thead>
<tr>
<th>Template</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SIMPLE.FRP</td>
<td>Includes a chromatogram and calibration curves per calibrated compounds.</td>
</tr>
<tr>
<td>NESTED.FRP</td>
<td>Shows how to nest subsections.</td>
</tr>
<tr>
<td>SPECTRA.FRP</td>
<td>Shows how to include spectra.</td>
</tr>
<tr>
<td>PURITY.FRP</td>
<td>Shows how to include peak purity data.</td>
</tr>
<tr>
<td>ESTD.FRP</td>
<td>Uses the same elements as the standard ESTD reports so you can customize</td>
</tr>
<tr>
<td></td>
<td>your external standard reports.</td>
</tr>
<tr>
<td>AREAPCT.FRP</td>
<td>Uses the same elements as the standard area percent report so you can</td>
</tr>
<tr>
<td></td>
<td>customize your area percent reports.</td>
</tr>
</tbody>
</table>

To test this template load a calibrated method.

Replace the logo by inserting your company logo as a "constant text" here.

The general section comprises elements that are valid for the complete data file. The elements below were inserted using the text and number tools.

Data File name: C:\HP\CHEM1\DATA\MSDEMO\CALCALC.D
Method name: C:\HP\CHEM1\METHODS\CALCALIB.M

| Data acquired by: |               | Date: 1/6/97 | Volume: 2.000 |

![Graph](image-url)
The Verification (OQ/PV) view lets Agilent service engineers test whether your analytical instruments and the ChemStation software are operating correctly according to predefined performance criteria.

**Operation Qualification (OQ)** Operation Qualification is the documented verification that the equipment-related system or subsystem performs as intended throughout representative or anticipated operating ranges.
Performance Verification (PV)  Performance Verification is the documented verification that the process and or the total process-related system performs as intended throughout all anticipated operating ranges.

System Diagram  Each icon of the system diagram represents one component or module of your system.

Verification Toolbar  The Verification toolbar is displayed when you select Show Top Toolbar from the View menu. Move the cursor over a button to view a description of it.

Available Tests  The following verification tests are supplied with your ChemStation software for use by an Agilent service engineer. Refer to the online Help for more information on these tests.

- VWD Wavelength Accuracy
- Intensity
- Holmium
- Temperature Accuracy
- Noise, Flow, Temperature
- DAD Wavelength Accuracy
- Injector Precision
- Detector Linearity/Carry-over
- Injector Linearity
- Gradient Composition
Diagnosis View

This view allows you to carry out diagnostic and maintenance activities on your system.

**Diagnosis Toolbar** The Diagnosis toolbar is displayed when you select **Show Top Toolbar** from the **View** menu. Move the cursor over button to view a description of it.
MSD Tune View

MSD Tune Toolset

This toolset is present in MSD Tune view.

- Load an MSD tune file.
- Save the current tune file.
- Generate a profile and scan report.
- Autotune the MSD and print a tune report.
- Calibrate the mass axis.
- Change spray chamber parameters.
- Edit MSD parameters for manual tuning.
- Acquire multiple scans and send results to data file.
# Basic Operation

## Start up and shut down the system

<table>
<thead>
<tr>
<th>Task</th>
<th>Instruction</th>
<th>Comment</th>
</tr>
</thead>
</table>
| **To start up the system**  | 1. From the Method and Run Control view, click the button on the system status bar. When you move mouse over the button, if system is currently idle, it turns green.  
2. Set up the LC conditions (pump, column heater, and detector).  
3. Set up the MSD spray chamber conditions as described in the MSD Spray Chamber dialog box topic in the online Help. Allow 15 minutes for the system to warm up. | This procedure assumes that the system is under vacuum and the LC and MSD are properly connected. It also assumes that the liquid flow path is properly set up. |
| **To put the system in Standby Mode** | 1. Flush the system with pure mobile phase to ensure that the flow path is clear of buffers. This prevents the nebulizer from plugging. A plugged nebulizer can cause a high back pressure, which can damage the LC flow cell. It is good practice to flush the flow path (including the column) for 5 to 10 minutes with a mobile phase without buffers such as 50:50 water/acetonitrile.  
2. Click the button on the system status bar. All modules are set to standby mode (indicated by the gray color in the system diagram). | Put the system in standby mode overnight or whenever you are not analyzing samples for an extended time. The standby state for the MSD leaves the nebulizer and drying gas on at low flow. Standby for the MSD is:  
• 20 psi for the nebulizer,  
• 3 L/min for drying gas,  
• 300 °C for drying gas temperature,  
• 325 °C for the APCI vaporizer, if present  
• the MS stream selection valve is set LC to Waste. For Agilent Jet Stream source:  
• Sheath temp 100°C  
• Sheath gas flow 2.2 L/minute |
Tune the MSD

When the MSD is used as a detector for the LC, a mass spectrum is associated with each data point in the LC chromatogram. To obtain high quality, accurate mass spectra, optimize the MSD to:

- Maximize sensitivity
- Maintain acceptable resolution
- Ensure accurate mass assignment

Tuning is the process of adjusting MSD parameters to achieve these goals. After the MSD parameters have been optimized, they must be saved in a tune file (.tun). This tune file is then specified in the method that is used to acquire data for your samples.

Frequent tuning, whether automated or manual, is not required. Once tuned, the MSD is stable. Tuning is needed no more often than monthly, weekly at most.

Wait 4 hours after pumpdown before tuning or operating your MSD. The analyzer takes about 11 hours to reach thermal equilibrium. Tune files that are created or data that is acquired before the MSD is at thermal equilibrium can have incorrect mass assignments and other inaccuracies.

<table>
<thead>
<tr>
<th>Task</th>
<th>Instructions</th>
<th>Comments</th>
</tr>
</thead>
</table>
| To use Autotune  | 1 From the MSD Tune view, select Autotune from the Tune menu or click the Autotune toolbar button.  
2 Review the tune report that is printed automatically when tuning is completed. | Use autotune for automated adjustment of the MSD performance. |
**Task** | **Instructions** | **Comments**
---|---|---
**To use Check Tune** | 1 Select Check Tune from the Tune menu.  
2 Review the Check Tune report. Adjustments are suggested for values that are outside of acceptable ranges. | Use Check Tune to determine quickly whether the MSD is correctly tuned. It performs a single profile scan of the tune masses and compares the peak widths and mass axes with target values.  

**To use Manual Tune** | 1 Select Manual Tune from the Tune menu.  
2 Set the desired mass resolution (adjusting width gain and width offset).  
3 Calibrate the mass axis (adjusting mass gain and mass offset).  
4 Optimize the ion transmission through the source ion optics (fragmentor, skimmer(s), lens 1, lens 2, and octopole peak).  
5 Adjust the signal strength (setting iris and adjusting the multiplier gain). | Use Manual Tune when you want to:  
• Achieve maximum sensitivity by sacrificing some resolution  
• Tune specifically for the very low end (<150 amu) of the mass range  
• Tune with a compound other than the standard calibrants  

Fragmentor and gain are method parameters. The fragmentor affects ion transmission and fragmentation. For more information, see the online Help.
Acquire MSD Data

Modes of Acquisition

There are three modes of acquiring data:

- Running a method for a single sample
- Running a sequence for multiple samples
- Running an FIA series

Note the following about acquiring data:

- All three acquisition modes require an appropriate method.
- Samples can be injected either manually or with an ALS.
- Always start a run from the software.
- An FIA method cannot be used in a sequence but multiple FIA methods can be run sequentially.
To edit a method and start a run

Once you know the acquisition mode that you want to use, you must set up an appropriate method. Methods are set up in the Method and Run Control view.

<table>
<thead>
<tr>
<th>Instructions</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Activate the single sample toolset by clicking the button on the toolbar.</td>
<td></td>
</tr>
<tr>
<td>2 Load a method by selecting Method / Load Method or by clicking the button</td>
<td>A series of dialog boxes is displayed, which allows you to set up your</td>
</tr>
<tr>
<td>on the toolbar and selecting a method from the list.</td>
<td>method and instrument parameters.</td>
</tr>
<tr>
<td>3 Click the button to begin editing the method. You can also begin by</td>
<td>Click the Help button on any of the method dialog boxes for descriptive</td>
</tr>
<tr>
<td>selecting Edit Entire Method from the Method menu or by right-clicking</td>
<td>information on the items available in each.</td>
</tr>
<tr>
<td>the icon on the Run Control Bar.</td>
<td></td>
</tr>
<tr>
<td>4 Select the method sections you want to edit (select all sections to</td>
<td></td>
</tr>
<tr>
<td>become familiar with the method parameters that are available) and click</td>
<td></td>
</tr>
<tr>
<td>OK.</td>
<td></td>
</tr>
<tr>
<td>5 Add any method comments you want to appear on your reports.</td>
<td></td>
</tr>
<tr>
<td>6 Set up the instrument parameters, such as pump, injector, DAD or VWD,</td>
<td></td>
</tr>
<tr>
<td>column thermostat, MS signals, and MS spray chamber.</td>
<td></td>
</tr>
<tr>
<td>7 Set up the Data Analysis parameters, such as signal details, integration</td>
<td></td>
</tr>
<tr>
<td>events, report parameters, instrument curves, calibration curves,</td>
<td></td>
</tr>
<tr>
<td>calibration table, and ion parameters.</td>
<td></td>
</tr>
<tr>
<td>8 Complete the Run Time Checklist.</td>
<td></td>
</tr>
<tr>
<td>9 Save the method using a different name. Select Method / Save Method As or</td>
<td>Once you are familiar with the options that are available, use the</td>
</tr>
<tr>
<td>click the button on the toolbar.</td>
<td>system diagram menus for quick access to particular method parameters.</td>
</tr>
<tr>
<td>10 When you are ready to begin a run, click the Start button.</td>
<td></td>
</tr>
</tbody>
</table>
Deconvolution

Deconvolution is an optional process (additional license required) that transforms mass spectra from multiply-charged ions into a calculated molecular weight.

To deconvolute a mass spectrum

<table>
<thead>
<tr>
<th>Instructions</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 In the Data Analysis view, load an electrospray MS data file. The TIC is displayed.</td>
<td></td>
</tr>
<tr>
<td>2 Generate the MS spectrum that you want to deconvolute. (Select the Spectral task tool set and use the spectrum selection tools to pick the spectrum of interest).</td>
<td>These operations are performed on data acquired in full scan mode.</td>
</tr>
<tr>
<td>3 Click the Enter Deconvolution Tool button to set up the deconvolution display area.</td>
<td></td>
</tr>
<tr>
<td>4 When the spectrum is displayed, click the Label Ions button to locate masses to be used in deconvolution.</td>
<td>You can use the Ion Label Options button to optimize the set of ions found.</td>
</tr>
<tr>
<td>5 Examine the ions that were found. Very noisy data or data with unresolved regions often need special settings to find ions.</td>
<td></td>
</tr>
<tr>
<td>6 Click the Edit Deconvolution Parameters button to change any of the parameters.</td>
<td></td>
</tr>
<tr>
<td>7 Click the Run Deconvolution button to begin the deconvolution process.</td>
<td>Once the deconvolution is done, the components are displayed in the upper right window. The charge states are displayed in the lower right window.</td>
</tr>
</tbody>
</table>
Deconvolution Report

The Deconvolution report contains summary information about each component selected, along with detailed information on how each peak in a component contributes to the molecular weight of the component. In the first part of the report, the components are ranked by percent relative abundance, which is useful for estimating the percent of impurities.

The actual molecular weight can differ from the computed molecular weight even if the data fit a Gaussian curve perfectly, due to other errors such as errors in mass axis assignment or unresolved chemical impurities.

The Deconvolution software is optional and is part of the ChemStation Edition C.01.xx or M8363AA (ChemStation C.0x) Bioanalysis Software package.

<table>
<thead>
<tr>
<th>Instructions</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>8 Select specific components from the Component list to look at individual components or groups of components.</td>
<td>Optionally, click the Preview Deconvolution Report button or click the Print Report button.</td>
</tr>
<tr>
<td>9 Optionally, select components from the Component List box and then click the Delete Components button.</td>
<td>This action removes the peaks for the selected components from the original spectrum. You can then continue with step 4 (previous), using this new spectrum.</td>
</tr>
<tr>
<td>10 Repeat the process.</td>
<td></td>
</tr>
</tbody>
</table>
Operating Tips

- Back up your data and methods **regularly** to avoid loss of data in case the files are accidentally overwritten, deleted, or if a hardware problem develops with your disk drive.

- Put the system in standby mode overnight or whenever you are analyzing samples for an extended time.

- Verify that the tune file you are using is appropriate for your samples.

- Save the Tune reports as a PDF file or print the report, as part of your maintenance log.

- Regular system maintenance can reduce problems. Keep a maintenance record.

- Use the Maintenance Logbook and EMF features in Diagnosis view to help you track when maintenance is needed and to keep an online maintenance record.

- Flush the sample path and clean the spray chamber, capillary tip, and spray shield daily or at the end of each shift. Check the foreline pump fluid level every week.

- The spray chamber vent hose must be connected to a lab vent that is used **only** for the source. The vent hose must be separate from the vent hose for the foreline pump. Otherwise, pump exhaust can migrate into the spray chamber vent producing chemical noise.

- Samples must be filtered. If no chromatography is used, they must be salt and detergent-free.

- If a UV detector is available, use it in series with the MSD. Try to minimize chromatographic peak broadening by using low dispersion tubing.
• To minimize chromatographic band broadening, be sure that all tubing connections are free of dead volume. Use zero dead-volume (ZDV) fittings when possible.

• Use the following table as a guide to using SIM, condensed scan, and full scan acquisition modes.

<table>
<thead>
<tr>
<th>Task</th>
<th>Mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>Acquire electrospray data for samples containing large, multiply-charged analytes.</td>
<td>Full Scan</td>
</tr>
<tr>
<td>Analyze a mixture with unknown components (small molecules).</td>
<td>Scan</td>
</tr>
<tr>
<td>Analyze a mixture with known components in unknown amounts (quantitate).</td>
<td>Scan or SIM</td>
</tr>
<tr>
<td>Identify the presence of a few known compounds at low levels within a mixture.</td>
<td>SIM</td>
</tr>
<tr>
<td>Use fast chromatography on 1.0-MHz MSD systems (LC/MSD and LC/MSD XT) without missing peaks.</td>
<td>Fast Scan</td>
</tr>
</tbody>
</table>
Troubleshooting Tips

No peaks
✓ Verify that there is spray from the nebulizer.
✓ Verify that the capillary voltage is set correctly.
✓ In APCI mode, verify that the corona needle is installed.
   In APCI mode, verify that the Corona Current setting is 2 μA or higher, and
   that the Corona Voltage is between 1500 and 5000 V.
✓ Verify that the MS system is tuned correctly.
✓ Verify that MS vacuum pressures are within normal ranges.
✓ Check the drying gas flow and temperature.
✓ Verify that the fragmentor is set correctly.
✓ Check if any error message indicates a problem with electronics.
✓ Verify that sufficient sample is present in vial.

Poor mass accuracy
✓ Recalibrate the mass axis.
✓ Verify that the ions used for tuning span the mass range of the sample ions
   and that they show strong, stable signals.

Low signal
✓ Check the solution chemistry. Verify that the solvent you are using is
   appropriate for your sample. Mixed samples can exhibit signal suppression
   of one or more components.
✓ Verify that the sample is fresh and has been stored correctly.
✓ Verify that the MS system is tuned correctly.
✓ Check the nebulizer condition.
✓ Clean the capillary entrance.
✓ Check the capillary for damage and contamination.
✔ Verify that the spray chamber parameters are set correctly, such as drying gas heater and nebulizer pressure.

**Unstable signal**

✔ Verify that the drying gas flow and temperature are correct for the solvent flow you are using.

✔ Verify that the solvent is thoroughly degassed. Do not use ultrasonic degassing with protein samples.

✔ Verify that the LC backpressure is steady; steady backpressure indicates a steady solvent flow.

**High spectral noise**

✔ Use appropriate mass filter values.

✔ Check the spray shape. Nebulizer can be damaged or incorrectly set.

✔ Verify that drying gas flow and temperature are correct for the solvent flow you are using.

✔ Verify that the solvent is thoroughly degassed. Do not use ultrasonic degassing with protein samples.

✔ Verify that the LC backpressure is steady; steady backpressure indicates a steady solvent flow.

✔ If you are using water as part of the mobile phase, verify that it is deionized (>18MΩ).

**Droplets, not spray, exiting the nebulizer**

✔ Verify that the nebulizing gas pressure is set high enough for the LC flow being used.

✔ Check the position of the needle in the nebulizer.

✔ Stop the solvent flow and remove the nebulizer assembly. Use a magnifying glass to examine the end of the nebulizer for damage.
Troubleshooting Tips
Deconvolution Report

No flow

✔ Verify that the LC pump is on and there is sufficient solvent in the correct bottle.
✔ Verify that the solvent supply lines are free of air bubbles. Purge the appropriate pump channels, if needed.
✔ Check for LC error messages.
✔ Check for blockages. Repair or replace any blocked components.
✔ Check for leaks.
✔ Verify that the MS stream selector valve is set to LC to MSD.

Undesired fragmentation

✔ Fragmentor is set too high.
✔ Ionization is causing fragmentation (APCI vs. Electrospray).
✔ APCI temperature is too high.
In this book

This book contains:

- Where to find more information
- What's new in C.01.07
- Configuration Diagrams
- ChemStation Edition Views
- Basic Operation
- Operating Tips
- Troubleshooting Tips